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はじめに 

 

伝染性造血器壊死症（IHN）は、マス類養殖において、最も被害の多い疾病の一つであ

り、長期にわたり生産に影響を与えてきた。さらに、近年では細菌性冷水病との混合感染

によって、その対応はより難しいものとなっている。原因の IHN ウイルスは、1970 年代

にアラスカから輸入された受精卵により国内に持ち込まれたと考えられている。その後、

国内で独自の遺伝的変異を続け、2000 年以降には新たな遺伝子型が出現したとされ、ウイ

ルスの遺伝的多様性は極めて高い。大型の個体にも感染する強毒化が指摘されており、こ

れ以上の変異の拡大と強毒化を阻止することが被害拡大防止のためには必要である。さら

に、近年、日本におけるサケ・マス等の海面養殖が盛んになっており、多く使用されてい

る米国産等の輸入魚卵に由来する魚が IHN に弱いことから、海面養殖の振興には、IHN ウ

イルスの防除や IHN 抵抗性の品種開発などが極めて重要となっている。 

 また、IHN は国際獣疫事務局（World Organisation for Animal Health[WOAH/OIE]）に

より国際的に監視されるウイルス病であり、活魚等の輸出入にあたっては、検査証明（無

病証明）が求められる。近年、世界的にサケ・マス類の需要が拡大し、日本で生産される

海面養殖ニジマス等がグローバルな商材として輸出も行われる可能性があり、輸出先の相

手国によっては、IHN の管理が求められる場合がある。 

 このような状況の中、国内のニジマス養殖等の実態をみると、IHN 感染耐過魚を種苗と

して使わざるを得ない場合が多く、種苗がキャリアとなってウイルスを排出し、環境中に

ウイルスが常に存在する状況となっている。このウイルスキャリア魚の存在は、ウイルス

の遺伝的な変異と強毒化を助長する原因ともなっていると推察される。そのため、令和元

年度から 5 年度にかけて、農林水産省戦略的プロジェクト研究推進事業「国内主要養殖魚

の重要疾病のリスク管理技術の開発」において東京海洋大学、長野県水産試験場、静岡県

水産・海洋技術研究所 富士養鱒場が共同研究として、飼育施設において IHN ウイルスを

清浄化することを念頭に、本ウイルスの動態などの疫学的な調査・研究を行った。その結

果を踏まえ、日本における IHN を制御し、これ以上のウイルスの変異・強毒化を阻止する

ための方策等について、その考え方を提言としてとりまとめた。また、本資料の付録とし

て、事業で取り組んだ IHN ウイルスの疫学調査のために構築した、本ウイルスの遺伝子型

の解析マニュアルを記載した。 
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1. IHN について 

サケ科魚類に発生する死亡率の高い疾病で、主に 15℃以下で発病する。症状として、

造血器の壊死による貧血や筋肉内の出血、腹水貯留による腹部膨満、眼球突出が見ら

れる。原因ウイルスはラブドウイルス科に属する IHN ウイルスであり、エンベロープ

を有する砲弾型の粒子で、1 本鎖 RNA ゲノム上に 5 つの構造タンパク質（N, P, M, G, 

L）と 1 つの非構造タンパク質（Nv）をコードする。 

 

 

 

＊新魚病図鑑第 3 版 緑書房 

＊西澤・吉水「伝染性造血器壊死症」魚病研究 52, 1-5 (2017) 

 

2. IHN ウイルスの変異・強毒化について 

IHN ウイルスは、もともと北米海岸のベニザケとマスノスケの稚魚の疾病として知

られる風土病的な存在であったが、1970 年代にアラスカからの輸入卵とともに国内に

侵入したと考えられている。北米西海岸のウイルスは、ウイルス粒子の表面にある G

タンパク質の遺伝子の配列を元にして、南から Lower（L）、Middle（M）、Upper（U）

の 3 つの遺伝子型に分けられる。アラスカの U 遺伝子型ウイルスが日本に侵入したた

め、日本での当初の流行ウイルスは U 遺伝子型であったが、その後、日本国内で独自

の変異を遂げ、静岡遺伝子型と長野遺伝子型へと分化し、さらに、2000 年以降では、

関東・甲信越地域では静岡遺伝子型が少なくなり、長野遺伝子型が主体を占めるよう

になるとともに、新たな北関東遺伝子型が出現している。このような遺伝的な多様性

が拡がるとともに、1980 年代までは 2g 程度の稚魚での発生であったが、1990 年代以

降には、100g を超えるような魚での発病や死亡が見られ、強毒化が進んできている。

採取年代の異なるウイルス株で感染試験を行うと、ウイルスの毒力は、新しいウイル

スほど強いが、G タンパク質遺伝子に基づいた遺伝子型とは直接相関しない。養殖生

産では IHN 生残魚から再生産を行ってきたため、ニジマスの IHN ウイルス感受性は

その選抜育種効果から徐々に低下してきたが、それを上回る速さで IHN ウイルスの毒

力が強くなっていると考えられている。毒力の増強は、ウイルスゲノム上の変異とし

て存在するはずであるが、その遺伝子配列はいまだ特定されていない。試験に供する

ニジマスの系統を変えると、毒力が変わることが知られ、ウイルスの毒力はそのニジ

マス系統との相互作用の結果として現れるため、その探索と特定は容易ではない。こ

の変異がニジマスの生産サイクルのどの段階で生じるのかは、変異を抑制する上で重

要であるが、今のところよく分かっていない。 

 
＊Nishizawa ら 「Nucleotide diversity of Japanese isolates of infectious hematopoietic necrosis virus (IHNV) 

based on the glycoprotein gene」Dis Aquat Organ. 30, 267-272 (2006)  

＊ Mochizuki ら  「 Virulence change of infectious hematopoietic necrosis virus against rainbow trout 

Oncorhynchus mykiss with viral molecular evolution」Fish Pathol. 44, 159-165 (2009) 
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＊Namba ら「Temporal change in genetical lineages of infectious hematopoietic necrosis virus (IHNV) in the 

north Kanto region of Japan from 1981 to 2015」Fish Pathol. 56, 35-42 (2021) 

 

3. 養殖場内の IHN ウイルスの動態と変異 

3.1 生産サイクルにおけるウイルス動態 

これまでに分かっていること：養殖の生産サイクルでは、受精卵を卵消毒して隔離孵

化施設へ収容後、IHN フリーで育成することができ、その後、外池に稚魚を移動し、

環境中に IHN ウイルスが存在すると、IHN が発生する。この稚魚期の IHN 発生事例

では、ウイルスを EPC 細胞やサケ科魚由来の CHSE-214 などの細胞で分離できる。

稚魚期の IHN が一旦終息すると、その後の感染耐過魚からウイルスは分離することは

できなくなる。これらの魚の一部は、親魚まで育成され、雌では成熟して体腔内に排

卵するときに、体腔液からウイルスが分離でき、雄では精液からウイルスが分離でき

る。このように、稚魚期に感染耐過した後の魚体内でのウイルスの存在状態は不明で、

成熟時に検出されるウイルスが、「稚魚の時に感染したウイルスが潜伏し、再び活性化

する」のか、あるいは、「稚魚のウイルスは一旦排除され、成熟時にウイルスが再感染

する」のか、２つのシナリオが考えられるが、明らかになっていない。 

ウイルス動態分析手法の構築：そこで、ウイルスの感染動態を明らかにするため、本

事業で IHN ウイルスの分子疫学的な分析手法を構築した（付録 マニュアルを参照の

こと）。ウイルスの遺伝子型は、従来、G タンパク質遺伝子ほぼ全領域で分析されてき

たが、かなりの分析労力・コストを必要とするため、G タンパク質遺伝子と N タンパ

ク質遺伝子のそれぞれ 500 塩基程度の配列を決定することとした。G タンパク質遺伝

子が類似しても、N タンパク質遺伝子が異なれば、ウイルス株間を区別することがで

きる。構築したこの判別法を用いて、長野県水産試験場及び静岡県富士養鱒場での IHN

発生事例を分析した。長野県水産試験場では、用水に上流の２つの養殖施設から多様

なウイルスが流入する。そのため、1 つの事例が遺伝子型の異なる多様なウイルスによ

り発生していることが判明した。さらに、IHN 発生事例で分離されたウイルスが年に

よって異なるなど、感染源の多様性を反映して検出できることが分かった。また、富

士養鱒場では湧水を用いており、外部から新たなウイルスが流入しない構造となって

いるため場内のウイルスの多様性が低いことが明らかとなった。このウイルス判別法

は、分子疫学分析に十分使用可能であることが判明した。 

今回の事業で判明したウイルス動態：構築した手法を用いて、稚魚のウイルスと親魚

のウイルスのつながりを調べるため、長野県水産試験場において、産卵親魚の体腔液

から分離したウイルスの遺伝子型を分析したところ、同じ産卵親魚群であっても、年

ごとに遺伝子型が変化することが明らかになった。さらに、稚魚に既知のウイルスを

感染させ、その稚魚を産卵親魚まで成育して体腔液からウイルスを分離してみると、

稚魚に感染させたウイルスは分離されず、その年の親魚群から分離されたウイルスの

遺伝子型と一致した。これらのことから、稚魚期に感染したウイルスは、魚体内から
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一旦排除され、免疫機能が低下する成熟の前に再感染することが示唆された。以上の

結果から、稚魚に感染したウイルスは、成長とともに一旦、魚体から排除され、成熟

時にその都度、環境中にあるウイルスに再感染し、このウイルスは卵消毒で排除され

る、というサイクルがあると推定される。つまり、ウイルスの変異・強毒化は、感染耐

過した育成魚において起こることを示唆しており、このことは、長野県水産試験場の

感染源である河川上流の２つの養殖場では、非常に多数の育成魚が飼育されおり、こ

の中から多様なウイルスが生じると考えて、大きな矛盾はないと思われる。 

加えて、死亡稚魚由来のウイルスと親魚体腔液由来のウイルスについて塩基配列に

基づいてハプロタイプとしてプロットをしてみると、両者のウイルスは、それぞれ塊

を形成し、遺伝的に区別されることが分かってきた。稚魚期の IHN 発生事例では、主

に強毒ウイルス株に感染した稚魚は死亡し、また、それらから排泄されたウイルスは

連鎖的な感染を引き起こし、事例としては、死亡稚魚から検出されるウイルスは遺伝

的に類似した塊を形成することになる。一方、主に弱毒ウイルス株に感染した稚魚は

感染耐過魚として生残することになるため、強毒株はその飼育生産サイクルから排除

されやすく、弱毒株が主に飼育生産サイクルに残りやすいものと推察される。従って、

親魚は、この生産サイクルに残ったウイルスに再感染することになるが、親魚由来の

ウイルスが遺伝的な塊となって検出されることから、成魚が成熟して免疫が低下する

過程において、感染耐過魚から排泄されるウイルスの中から、親魚体内で増殖できる

性質を備えたウイルスが感染し、親魚群に感染が拡がると考えると、妥当なように思

われる。なぜ親魚の体腔液から検出されるウイルスが遺伝的な塊として検出されるの

か、その原因・理由について、さらなる研究により明らかにしていく必要がある。 

 

3.2 ウイルスの持続感染と変異・強毒化 

外観的に健康に見える感染耐過魚の一部では、魚体内でウイルスが免疫に押さえ込

まれながらも、魚体にダメージを与えない程度に細々と持続的な感染を起こしている

ことが想像される。このような状態はどのように起こるかは不明であるが、養殖施設

では、孵化施設から外池に移送し、ウイルスに感染させ、感染耐過魚を作出し、免疫

のある養殖種苗として利用せざるを得ない現状と密接な関係にあると考えられる。養

殖場でのその作出操作では、累積死亡率は 2 割以下程度とのことである。 

そこで、この死亡状況を参考に、実験感染に耐過して外観では健康となった魚を経

時的にデキサメタゾンとシクロスポリンを注射投与して免疫を抑制して魚体内からの

ウイルスの分離を試みた。その結果、強毒のウイルス株に感染し 60%以上の高い累積

死亡率の耐過魚群では、感染終息後、直ぐにウイルスが分離できなくなるが、弱毒の

ウイルス株に感染し 10~20%程度の低い累積死亡率の耐過魚群では、感染後 4 ヶ月後

でもウイルスが分離できる場合があった。従って、養殖場で行われる低い死亡率での

感染耐過魚の作出によって、感染耐過魚群内では主に弱毒ウイルスの持続感染を引き

起こし、育成される過程でウイルスを排泄し、感染源となることが推定される。また、
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この育成期間での持続感染の状態では、魚体内からのウイルスの完全な排除ができな

いものの、環境中に IHN ウイルスが存在しても発病・死亡しない免疫が成立している

状態と考えられる。持続感染したウイルスが免疫から逃れようとする過程で変異が起

こり、その中には強毒ウイルスも発生し、全体で見れば、そのニジマス系統に対して

一定の毒力の強化が起こるのではないかと想像される。これが、日本に侵入して以来、

ウイルスの毒力が宿主の抵抗性を上回って変異・強毒化してきた原理と推測される。

つまり、稚魚期の IHN での生残魚を親魚とする選抜育種を行っているものの、その効

果が出ず、ニジマスの抵抗性の増強につながらない理由と推察される。 

以上、IHN ウイルスの変異・強毒化のポイントをまとめると、 

1) 稚魚期に IHN ウイルスに感染・耐過した育成魚は、IHN に対して免疫を得るが、

魚体内ではウイルスの持続感染を起こす。育成過程でその免疫を回避しようとする

ウイルスの変異が起こり、その中に毒力の強いウイルスが発生する。 

2) その結果、稚魚－育成魚－親魚の生産サイクルにウイルスが入ると、そのニジマ

ス系統の魚に対する毒力が上昇するため、IHN に対する選抜育種効果が出ない。た

だし、その系統の魚に毒力が高くても、違う系統の魚に対しても毒力が高いとは限

らない。 

 

4. 変異・強毒化を抑制するための考え方 

 上記のポイントに沿った対策を考えると 

＊ 養殖として大量に飼育される稚魚・育成魚にウイルスを感染させない。 

  ＊ 養殖に用いるニジマス系統に対してウイルスを強毒化させないため、稚魚－育成

魚－親魚の生産サイクルにウイルスを入れず、感染耐過魚を親にしない。 

 を達成する必要がある。 

  これを実践するためには、ウイルスフリーの環境が得られる湧水・地下水を用いる

施設と、ウイルスが環境中に存在する河川水利用の施設に分けて考える必要ある。 

1) ウイルスフリーの環境が得られる湧水・地下水を用いる施設（特に種苗生産施設） 

＊原則は、施設全体で IHN フリーを目指す。受精卵は消毒し、池出し稚魚にウイルスを

感染させることなく、育成する。 

＊一部だけ河川水を利用する施設では、UV 殺菌装置などによって用水からウイルスを

排除し、ウイルスの施設内への侵入阻止を行う。 

＊IHN フリーではない他の養殖場に種苗を販売する場合は、販売元でウイルスに感染さ

せることなく、販売先で感染耐過魚の作出の処理を行う。 

＊他所から種卵を導入する場合には、必ず卵消毒を行う。 

＊親魚候補となる稚魚は、最上流部へ池出しし、育成過程での万一の IHN 発生に備え

て別に育成し、育成魚群の排水が入らない池で育成する。 

＊他の養殖場から持続感染魚を導入してしまうと、育成魚が感染するため、他所からの

魚の導入は行わない。どうしても他所から魚を導入する場合には、IHN フリーの養殖
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場間での導入・移動を基本とする。 

＊池出し後の死亡稚魚あるいは異常稚魚は、水産試験場等でのウイルス検査を行い、

IHN による死亡あるいは発病でないことを毎年確認する。 

＊IHN の発病がないことを直近 2 年間にわたって確認し、IHN フリー施設とする。 

 

2) ウイルスが環境中に存在する河川水利用の施設  

＊IHN フリーで飼育が難しいため、IHN に免疫のある魚を用いた養殖生産が基本とな

る。 

＊種苗にはウイルスフリーの種卵あるいは魚を導入し、環境中に存在する IHN ウイル

スの感染による感染耐過魚の作出を行い育成魚とする。 

＊この育成魚はウイルスキャリアであるため、IHN フリー養殖場には販売せず、同じよ

うに IHN フリーではない養殖場間での移動を基本とする。 

＊施設内は常にウイルスが存在する状態であり、特に、用いる系統のニジマスに対して

毒力が上昇するため、上流に若い魚を配置し、下流に向けて年級ごとに管理する。 

＊各年級群はすべて販売し、感染耐過した育成魚は親魚にせず、長期間の育成を行わな

い。 

＊種苗生産は感染耐過魚を利用せず、違う施設で行う。あるいは、UV 殺菌した給水を

独立した池に引き込むなど、IHN ウイルスフリーでの親魚養成を行う。 

＊現在、日本では利用できないが、カナダ等では IHN に対する DNA ワクチンが使用さ

れている。日本でこのような IHN ワクチンが認可されれば、野外のウイルスを利用

した感染耐過魚の作出は止め、IHN 対策としてワクチンを用いることにより、環境中

のウイルス量は減少し、ウイルス変異・強毒化のリスクは大きく減少すると考えられ

る。 

 

5. 施設の清浄化 

現在は、多くの施設で感染耐過魚を用いた養殖が行われている。そのため、上に示し

た 1)のウイルスフリー施設では、順次、清浄化を行っていく必要がある。 

＊新しく導入する年級群から清浄化を行い、IHN ウイルスフリー化をすすめる。下流

側に前年度のウイルスキャリア群がいるため、間の水槽を空けるなど、両群が接触し

ないように十分注意する。 

＊特に、長期間飼育する親魚群の育成は、育成群とは別に IHN ウイルスフリーを担保

できるように、育成魚の排水を使わずに親魚候補を育成する。 

＊すべて IHN フリー魚に入れ換えた後でも、IHN の発生が確認された場合は、その感

染源を特定し、排除する。 

＊清浄化の完了以降においては、池出し後の死亡稚魚あるいは異常稚魚は、水産試験

場等でのウイルス検査を行い、IHN による死亡あるいは発病でないことを毎年確認す

る。 
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＊IHN の発病がないことを直近 2 年間にわたって確認し、IHN フリー施設とする。 

 

感染源の特定には、養殖業者への聞取り・現場での調査などを以下のポイントに従い

行う。 

【チェックポイント】 

施設 

＊水源からの給水に感染耐過魚はいないか 

＊給水に他の水槽の排水が入り込んでいないか 

＊水槽の間に割れ目や他の水槽からの水しぶきなど水のつながりはないか 

＊施設内にウイルスを持ち込む可能性のある動物の侵入はないか 

 

管理・操作 

＊卵消毒はきちんと行われているか 

＊死卵は適切に処分されているか 

＊死亡魚の取扱いと処分は適切か、取り扱った網は操作後すぐに消毒されているか、

他の池に使用していないか 

＊死亡魚を凍結保存している場合など、冷凍庫を起点としたウイルスの拡散はないか 

＊操作者の長靴や手指の消毒は適切に行われているか 

＊池や水槽ごとに器具や道具を変えているか 

さらに、必要に応じて疫学調査（付録参照）を実施し、感染源を特定する。 

 

IHN による被害を軽減するための簡易チェックシート 

IHN ウイルスキャリア魚の流通による疾病被害やウイルスの強毒化を抑えるために日

ごろから意識してほしい項目について、リストアップしました。項目はチェックして欲

しい順番に並んでいます。 

現在または今後の飼育管理の参考にしてください。 

 

・ウイルスフリーの用水（湧水・地下水）を使用している施設（特に種苗生産施設）では

IHN フリーの維持を徹底する。 

□ 作業者の手指、飼育器具および施設へ入る際の消毒を徹底する。また、施設に入る

際は専用の作業着に着替えることを徹底する。 

□ 同じ養殖場内に河川水を利用する池がある場合は、湧水・地下水利用区画と河川水

利用区画との器具類等の区別を徹底する。また作業時の順番を考慮し汚染が生じな

いように細心の注意を払う。 

□ 水源からの給水過程で IHN ウイルスの侵入がないか確認する。 

□ 同じ養殖場内に河川水を利用する池がある場合は、UV 殺菌装置やオゾン殺菌によ

って用水からウイルスを排除する。 
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□ 受精卵の洗卵・消毒を徹底する。 

□ 他所から種卵を導入する場合には、必ず卵消毒を行う。 

□ 孵化後の稚仔魚に異常はないか確認する。 

□ 他所からの魚での導入は行わない。どうしても他所から魚を導入する場合には、

IHN フリーの養殖場から導入する。 

□ 池出し後、死亡稚魚あるいは異常稚魚はいないか。いる場合には、水産試験場等で

のウイルス検査を受け、IHN の発生がないことを確認する。 

 

 

・ウイルスが環境中に存在する河川水利用の施設では IHN ウイルスの強毒化を抑えるこ

とを念頭におく。 

□ 施設内に存在するウイルスの強毒化を防ぐため、上流に若い魚を配置し、下流に向

けて年級ごとに管理する。 

□ 育成魚はウイルスキャリアであるため、IHN フリーの養殖場には販売せず、同じよ

うに IHN フリーではない養殖場間での移動を基本とする。 

□ 各年級群はすべて販売し、長期間の育成を行わない。（長期間の育成中にウイルスが

強毒化する恐れがある。） 

□ IHN ウイルスフリーで親魚養成を行い、種苗生産には感染耐過魚した親魚は利用し

ない。 
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おわりに 

 

IHN ウイルスのこれ以上の強毒化を阻止することは、海面養殖も含めた日本の養鱒業

の持続的な発展には欠かせない。特に、ウイルス変異・強毒化の発生メカニズムを理解

し、養鱒業界全体で IHN フリーの施設と IHN 発生施設の 2 つのコンパートメントに明

確に分けて運用し、ウイルスの変異誘導・強毒化を国・都道府県と連携しつつ管理する

ことが重要である。もちろん、現段階では、施設の制約上、直ぐに対応できないかもし

れないが、方向性をきちんと見定め、計画性を持って進めていく必要がある。また、減

耗要因となる疾病は、IHN だけではなく、一つ一つ対応し、将来の脅威を減らしていく

ことが養鱒の持続的発展に不可欠と考える。 
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付録 

 

【IHN ウイルス分子疫学のための遺伝子配列解析マニュアル】 
 

本マニュアルは、施設内の IHN ウイルスの分子疫学的な分析を行うための、基本的な技

術を取りまとめた。疫学調査は、対象となる材料からの IHN ウイルスの分離、ウイルスゲ

ノムの N タンパク質および G タンパク質の遺伝子領域の一部の塩基配列の決定、その比

較･解析という流れとなっている。疫学調査の目的を明確にし、そのために、調査対象を何

にし、いつ、どのぐらいのサンプル数を採取するかなど、十分に検討して計画を立てるこ

とが重要である。 

 

１．ウイルス分離 

(1) IHN 死亡稚魚 

IHN 発生群の死亡魚は、すべての個体からウイルスが分離されることが予想されること

から、必要な分離株数の尾数を確保する。通常の分析では 1 時点 10 尾程度で十分である

が、経時的な分析を行いたい場合には、死亡発生後の死亡数の増加期、死亡ピーク時、終

息の時期などで魚をサンプリングする。0.5g 以下のごく小さな稚魚では、魚全体を磨砕す

るが、凍結保存する場合にはそのまま-30℃以下に凍結保存する。それよりも大きな稚魚で

は、腎臓あるいは脾臓を 1.5mL マイクロチューブなどに採取し、保存する場合には-30℃以

下で行う。やむを得ず、魚ごと凍結保存する場合には、凍結魚を流水などで手早く解凍後、

臓器を採取して磨砕しても良い。5g 以上の比較的大型の稚魚では、そのまま凍結すると解

凍に時間がかかり、ウイルスが失活しやすいので、できる限り臓器を採取してから凍結保

存する方が良い。 

EPC 細胞等を用いてウイルス分離を行う。1.5mL マイクロチューブでのウイルス分離で

は、臓器をマイクロペッスルでホモジナイズし、MEM-H3（HEPES 緩衝の MEM に牛胎児

血清 FBS3%と抗生物質所定量を添加）を臓器重量の 9 倍量加えて良く懸濁させた後、4℃、

8,000 rpm で 5 分間遠心分離する。上清を採取し、上清 9 容に市販の 100 倍濃度の抗生物質

液（ペニシリン 10,000 単位・ストレプトマイシン 10,000μg/mL）1 容を加え（終濃度は通常

の 10 倍濃度）、混和後、4℃で一晩静置する。翌日、あらかじめ MEM-3（HEPES 添加・非

添加どちらでも良い）で前日に作製しておいた EPC 細胞を播種した 96well マイクロプレ

ートに、感染価測定の要領で 1/10 希釈列を各希釈 4well 以上に接種する。15℃で 2 週間以

上培養し、最も高希釈で細胞変性効果 CPE を示した well からウイルスを回収する。このよ

うにすることで、IHN 流行時の複数株の同時感染が起こっている場合でも、その魚体内で

最も多く存在したウイルス株を得ることができる。必要に応じて、96well から回収したウ

イルス液（約 0.15mL）を 1mL 程度の MEM-3 と混合し、（抗生物質法では完全に除菌され

ていない可能性が高いため）0.45μm ポアサイズの PVDF シリンジフィルターで濾過後、培

養液で 1/10 希釈し、50μL を 24well プレートに播種した EPC 細胞に接種する。残りの濾過

液は、-80℃に凍結保存する。プレートは 15℃で培養して CPE が完結したら、RNA 抽出用
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に使用キットの必要量（200μL 程度）採取した後、残りの培養液を分離ウイルス株保存液

として-80℃に保存する。 

 

(2) IHN 発生群の生残魚 

IHN 発生群で死亡が終息したのち、魚をサンプリングすると、感染耐過した生残魚のサ

ンプルを得ることができる。死亡が止まり、外観や餌食いの異常がなくなると、ウイルス

の分離率が急激に低下するため、必要な分離株数の数倍の尾数を確保する。また、回復後、

少し時間が経ち、通常の方法ではウイルス分離が困難な魚群では、免疫抑制剤を投与する

ことで分離率を上げることができる。免疫抑制剤にはデキサメタゾン（5-10g 程度の稚魚に

20μg/尾）とシクロスポリン（50μg/尾）を用い、15℃で飼育された対象魚に両剤を混合して

2 日おきに計 5 回腹腔内投与し、最終投与の翌日に腎臓を採取し、ウイルス分離に供する。 

腎臓からのウイルス分離の方法は、上記の「(1) IHN 死亡稚魚」と同様にホモジナイズし、

遠心分離上清を抗生物質処理した後、その 50μL を 24well プレートに播種した EPC 細胞に

接種し、15℃で 2 週間以上培養する。CPE が完結したら、RNA 抽出用に使用キットの必要

量（200μL 程度）採取した後、残りの培養液を分離ウイルス株保存液として-80℃に保存す

る。この保存ウイルスを継代培養するときには、0.45μm ポアサイズの PVDF シリンジフィ

ルターで濾過後、EPC 細胞に接種する。 

 

(3) 産卵親魚体腔液 

 成熟親魚では、体腔液あるいは精液からウイルスを分離することができる。受精に際し

ては、雄は多くの個体を使わないことが多く、また、雌の産卵時の体腔液の方が概ねウイ

ルス分離率が高いため、産卵親魚の体腔液を対象とするとよい。ウイルス分離率は、養殖

場の状況や産卵親魚群によりかなり変わり、ほとんど採れない群から 3 割ぐらい採れる群

もあるが、陽性率が不明な場合には、1 割程度の分離率を想定し、必要な採材個体数を決定

する。例えば、ウイルス 10 株が必要な場合には、100 尾程度の産卵親魚を対象とする。 

体腔中に排卵された個体から卵を絞る前に、生殖口から 1000μL のチップを挿入し、0.7-

1mL 程度の体腔液を得る。体腔液を 2mL あるいは 1.5mL マイクロチューブに入れ、可能

であれば FBS を 300μL 程度添加し（凍結によるウイルス失活を軽減できる）、-80℃に保存

する。体腔液には、多いものでは 107 TCID50/mL 程度と多量にウイルスが含まれているもの

があるが、多くが 103 TCID50/mL 程度のウイルスしか含まれていないため、ウイルスの失活

に注意する。体腔液には卵菌や真菌などペニシリン・ストレプトマイシンで殺菌できない

微生物が混入していることが多いため、抗生物質法よりもフィルター濾過法が良い。除菌

できず、微生物の混入よって分離し直すために、体腔液を何

度も凍結融解すると、体腔液中のウイルスが失活し、分離で

きなくなることがある。 

解凍した体腔液をマイクロチューブから 1mL ツベリクリ

ンシリンジで吸い上げ、0.45μm ポアサイズの PVDF シリン

ジフィルターをセットして濾過する。前日に準備した 24well
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プレートに播種した EPC 細胞の各 well（培養液 1mL）に 20%のポリエチレングリコール

20000 液（オートクレーブ滅菌しておく）を 50μL 加え、軽く揺することで混合する（終濃

度 1%：分離率が若干上がり、CPE の出現が早くなる）。ここに、濾過した体腔液 70-100μL

を接種し、15℃で 2 週間以上培養する。CPE が完結したら、RNA 抽出用に使用キットの必

要量（200μL 程度）採取した後、残りの培養液を分離株保存液として-80℃に保存する。 

 

2. ウイルスゲノム RNA 抽出と cDNA 合成 

 EPC 細胞で培養されたウイルス液には、107～8 TCID50/mL の大量のウイルスが含まれるた

め、おそらくどのような RNA 抽出キットを用いても、RT-PCR のテンプレートとして使用

可能と思われる。本事業では、Roche 社の HighPureViralRNAKit を用い、プロトコルに従っ

て RNA を抽出した。最終的な RNA 抽出液は-80℃に保存する。IHN ウイルスのゲノム RNA

は一本鎖であり、RNase によって速やかに分解されるので、取り扱いに注意する。 

次に、ゲノム RNA を逆転写酵素によって相補的な DNA(cDNA)を合成する。N と G の両

遺伝子を増幅するため、random hexamer を用いて合成を行う。ウイルスゲノムはより高い

反応温度の方が cDNA 合成がうまくいくため、50℃程度以上の温度で反応できる逆転写酵

素を用いる方が良い。本事業では ThermoFisher 社の SuperScript IV Reverse Transcriptase を

用いた。PCR 用チューブに 50μＭ random hexamer を 1μL、10mM dNTP mix を 1μL、ヌクレ

アーゼフリーDW を 5μL、RNA 抽出液（10pg－5μg）を 6μL 入れて全体を 13μL とし、軽く

スピンダウンした後、サーマルサイクラーで 65℃、5 分間反応させる。これに 5×SSIV Buffer

を 4μL、100mM DTT を 1μL、RNase OUT™ Recombinant RNase Inhibitor を 1μL、SuperScript 

IV Reverse Transcriptase を 1μL を加え、全体量を 20μL とする。再びサーマルサイクラーで

23℃ 10 分間、50℃ 10 分間、反応終了後 4℃に冷却する。合成した cDNA は-80℃で保管す

る。 

 

3. シーケンス 

使用プライマー 

N タンパク質遺伝子の上流域の部分塩基配列（Accession No. JX649101.1 : IHNV HLJ-09

株 の 170nt-835nt の 666bp ） を 増 幅 す る Forward プ ラ イ マ ー （ 5´- 

GAACGATGACAAGCGCACTC - 3´ ） と Reverse プ ラ イ マ ー （ 5´- 

CTGTCCCGCTCAGTCTCATG - 3´）、G タンパク質遺伝子の中流域の部分塩基配列（Genbank 

Accession No.LC148372.1 : IHNV GM1501 株の 294nt-995nt の 702bp）を増幅する Forward プ

ライマー（ 5´- CATCCACAAAGTCCTGTACC - 3´ ）と Reverse  プライマー（ 5´ - 

GATAGGAGGTATGGAGTCACAC- 3´）を用いて、G と N のタンパク質遺伝子それぞれを増

幅させる。PCR における塩基合成エラーを防ぐため、通常の Taq DNA 合成酵素ではなく、

合成反応が正確な酵素、例えば KOD DNA 合成酵素（TOYOBO 社）などを用いる。本事業

では KOD 酵素を用いた。反応液は cDNA 1μL、滅菌蒸留水 15.5μL、10×KOD buffer 2.5μL、

2mM dNTPs 2.5μL、25mM MgSO₄ 1μL、KOD plus 0.5μL、Primer（10 pmol/μL）各１μL 加

えて全体量を 25μL とする。反応条件は 94℃で 2 分間保持した後、94℃で 15 秒間の熱変
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性、60℃で 30 秒間のアニーリング、68℃で 35 秒の伸長反応のサイクルを 30 回行い、反応

終了後 12℃に保持する。 

DNA の増幅を確認するため、1×TAE buffer に Agarose S が 2％になるように調節したア

ガロースゲルを用いて電気泳動を行う。ゲルの端に分子量マーカーである 100 bp DNA 

Ladder を流し、その隣から 10×Loading Buffer を添加した PCR 産物 4μL を入れ、約 20 分

間電気泳動を行う。その後、Midori Green Advance DNA Stain (Nippon Genetics Europe GmbH ) 

に 15 分間ほど浸し、トランスイルミネーターで寒天中の目的バンドを確認するとともに、

目的以外のバンドないことも確認する。 

塩基配列は委託業者へ依頼する。送付物は委託業者の指示に従うが、本事業では PCR 産

物を 15～60ng となるように希釈し、増幅に使用した一種類の primer（Ｎ遺伝子は Forward, 

G 遺伝子は Reverse）を加え、計 21μL となるように滅菌水で調節した。これを送付し、DNA

の塩基配列データを得る。PCR 産物に対して一方のプライマーから塩基配列を解読するこ

とで、両方のプライマーで読むよりも半分のコストで塩基配列の決定ができる。ただし、

プライマーの直ぐ下流の配列データはうまく塩基配列が得られにくいため、その部分を取

り除き、十分塩基配列が解読できる領域として N タンパク質遺伝子では HLJ-09 株の 260nt-

801nt（542bp）の領域、G タンパク質遺伝子では、GM1501 株の 314nt-871nt（558bp）の領

域の合計 1,100 pb の配列データを用いる。そのため、次でデータのトリミングを行う。 

 

4. 分子系統樹の作成 

＊使用するソフトウェア：MEGA (最新のバージョン等) 

 以下に解析の一例を示すが、MEGA の使用法については、いろいろな資料がネットで

得られるので、詳しくはそれらを参照のこと。 

 

① 委託業者から送られてきたデータファイルを解凍し、AB1 ファイルの波形データを確

認する。(AB1 ファイルの開き方：MEGA を立ち上げ、File→Open a file で任意の AB1

ファイルを選択) 
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② 波形がきれいなことを確認して、上流の読み取れていない領域と下流のプライマー20

塩基（上部に塩基が示されており、N が多く含まれている領域：下のグレーの部分）

を切り取る。今回の解析対象領域よりも下流側の配列を長く使う場合には、PCR プラ

イマー配列は必ず取り除くこと。下の図のように、Edit→Unmask Upstream あるいは

Downstream を使って、取り除きたい部分を指定するか（保存したときにその部分は取

り除かれている）、その部分の塩基配列を指定して、Delete キーで削除する。Reverse

プライマーで増幅した G 遺伝子のデータは相補で逆向きにするため Reverse 

complement を実行する（データを指定して Edit→Reverse complement）。その後、

Data→Export FASTA File で FASTA ファイルとして保存する。 

 

 

 

③ N と G 遺伝子の配列を一緒にするため、まず、両方の FASTA ファイルをメモ帳で開

く。ファイルのアイコンで右クリックし、「プログラムから開く」でメモ帳を選択す

る。FASTA 形式は、次のように 

>名前 ↲（すべて半角：名前の後にリターンが入る） 

GCACCATCT･････････GGGTTCTTCG 

という形になっている。 
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同一サンプルの塩基配列をＮの配列の後に、Ｇの配列をコピーし、結合した配列のサン

プル名（「>名前」の部分が MEGA で sequence 名として現れ、リターン以降が塩基配列

として認識される）の「>」の後に新しい sequence 名（たとえば、HV2401N+G）を記す。

「名前を付けて保存」からその名前をファイル名に入力し、それに続けて「.fas」と入力

し（HV2401N+G.fas）、その下の「ファイ類の種類」で「すべてのファイル」を選択し、

保存する。 

 

④ 必要な配列をメモ帳から全て MEGA にコピー＆ペーストし、次の解析に用いる N お

よび G タンパク質遺伝子の領域を参照配列から取り出してきた次の調整用の塩基配列

もペーストする。 

 

調整用塩基配列： HLJ-09 株 260nt-801nt(N) + GM1501 株 314nt-871nt(G)  (1,100bp) 

>Template(N+G) 

ccggtacgataaccctccctctcttcttctccaaggcagactttgaactagagatgattaagcgggcggtgagtcacgtcggaggagagg

gaacgagaagggcattgggcctcttgtgcgcgttcgtcattgcggagacggtcccatcggggacaggcacggtcgccgaaactctgga

agccctgggcttcttgctggagtctttggacactggggcaccactggacgccactttcgcagatcccaacaacaagcttgcagaaacgat

cggaaaggaaaatgtccttgaggttgtgaccggcctcctcttcacctgcgctctactgacgaagtatgacgtggacaagatggccatatac

tgccaaaacaagctcgagcgtcttgcaaccagccaagggattgacgagttggtcaacttcaactccaacaggggagtgctggccaagat

cggggcggtacttagacctggacagaagctcaccaaggctgtttatgggatcattctcatcaacctgtctgacccagccaccgccgctag

agccgcaccatctgctcaacagggttcttcgggggtcagacgatagagaaggtgcttgtagaaatgaaactctccacaagagaagcagg

ggcatatgacaccacaaccgcagccgctctgtacttcccagctccccgatgccaatggtacaccgacaacgtacaaaatgatctcatcttc

tactacacaacccaaaaaagtgttctgagagatccctacaccagagactttctggactcagattttattggagggaaatgcactaaatcacc

ctgccagactcattggcccaacgtagtttggatgggcgatgcagggataccagcctgtgacgccagcccagagataaacggtcacctctt

tgttgataaaatctccaatcgagccgtgaaggcaacgagctacggacaccacccctggggactgcatcgggcctgtatgattgaattctgt

ggggggcagtggatacggacagatctcggcgacctgatatctgtagcataccattctggatcaaaaaccctctcgttcccgaagtgtgag

gacgagaaggtggggatga 

 

 

 

⑤ 次に、分析に必要な塩基配列の領域にするため、2 つの配列を整列させる。2 つのシー

ケンスを指定して、Alignment →Align by ClustalW で整列させる。調整用の配列にな

い部分、配列の上流側と下流側および両遺伝子を結合させた部分を見つける。下の図
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では N 遺伝子と G 遺伝子の境界部分で調整用配列にない部分がクリーム色で示されて

いる。調整用塩基配列に合わせて、不要な領域をトリミングする。トリミング後は調

整用塩基配列を削除する。 

 

 

 

⑥ 新しい配列の sequence 名のところにカーソルを持って行き、右クリックすると「Edit 

sequence name」が出てくるので、ここに新しい名前（たとえば、HV2401N+G ed な

ど）を記入する。このファイルを FASTA ファイルで保存する。Data→Export alignment

→FASTA format で名前を入力して保存する。同じように他のシーケンスデータも比較

領域に合わせたシーケンスデータを整える。 

 

⑦ 比較したいデータが揃ったら、各 FASTA ファイルをメモ帳で開き、1 つのファイルに

すべてのデータを FASTA の形式になるように並べて貼り付ける。遺伝的な位置を示し

たい場合には、長野遺伝子型や北関東遺伝子型の配列データ、また、アウトグループ

として日本の U 遺伝子型などのデータを一緒に解析する。本マニュアルの最後に 1976

年に長野県で分離された HV7601（U 遺伝子型）を示した。このファイルを一旦新し

い名前（たとえば、HV2301-10 2401-10N+Ged.fas）で保存する。これを MEGA の

Align のモードで開くと、すべてのデータが一度に表示される。すべてのシーケンスを

選択して、再度、Alignment →Align by ClustalW で整列させる。念のため、このデー

タを FASTA で保存しておく。 

 

⑧ 次に整列させた状態で、Deta から DNA sequence になっていることを確認し、Data→

Phylogenetic analysis をクリックする。タンパク質コードの塩基配列かどうか聞いてく

るので、「Yes」を選択する。MEGA のもう一つの画面の Phylogeny をクリックし、

→Maximum Likelihood 法を選択する。現在使用中のファイルか聞いてくるので、

「Yes」をクリックすると、分析条件が表示される。Bootstrap 値をつける際は、「Test 

of Phylogeny」の none となっているところを Bootstrap method を選択肢、その下に行い

たい回数を入力する。他は基本的にデフォルトで良い。データがかなり多い場合に

は、1,000 回繰り返し解析を行うと数時間がかかることもある。その場合には、
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Neighbor Jointing 法で行うこともできる。各解析法については、解説書を読み、解析す

る目的に合った方法を選ぶ。 

解析が終わると系統樹が出力される。サンプルの表示位置の入替などが可能であ

り、目的にあった樹形の表示に整える（詳しくは MEGA の使い方を参照）。MEGA の

ファイル形式、あるいは Image から PDF や TIFF などの適当な画像ファイルとして保

存する。 

このように作成した分離ウイルスの分子系統樹を利用し、現場での施設内の構造や

魚の搬入・移動、飼育等の操作などの聞き取り等と合わせて、施設内の IHN ウイルス

の関係や動態、さらには感染源などについて疫学的な調査を進める。 
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1976 年の分離ウイルス HV7601 の N+G 参照配列データ（U 遺伝子型）(1,100bp) 

>HV7601 

CCGGTACGATAACCCTCCCTCTCTTTTTCTCCAAGGCAGACTTTGACCTAGAGATGATCAAGC

GGGCGGTGAGTCACGTCGGAGGAGAGGGAACGAGAAGGGCATTGGGCCTCCTGTGCGCGTT

CGTCATTGCAGAGACGGTCCCATCGGGGACAGGCACGGTCGCCGAAATTCTGGAAGCCCTGG

GCTTCTTGCTGGAGTCTTTGGACACTGGGGCACCACTGGACGCCACCTTCGCAGATCCCAAC

AACAAGCTTGCAGAAACGATCGTAAAGGAAAATGTCCTTGAGGTTGTGACCGGCCTCCTCTT

CACCTGCGCTCTACTGACAAAGTATGATGTGGACAAGATGGCCACATACTGTCAAAACAAGCT

CGAGCGTCTTGCAACCAGCCAAGGGATTGGCGAGTTGGTCAACTTCAACGCCAACAGGGGA

GTGCTGGCCAAGATCGGGGCGGTACTTAGACCTGGACAGAAGCTCACCAAGGCTATCTATGG

GATCATTCTCATCAACCTGTCCGACCCAGCCACCGCCGCTGAAGCCGCACCATCTGCTCAACA

GGGTTCTTCGGGGGTCAGACGATAGAGAAGGCGCTTGTAGAAATGAAACTCTCTACGAAAGA

AGCAGGGGCATATGACACCACAACCGCAGCCGCTCTGTACTTCCCAGCTCCCCGATGCCAATG

GTACACTGACAACGTACAAAATGATCTCATCTTCTACTACACAACCCAAAAGAGTGTTCTGAG

AGATCCCTACACCAGAGACTTTCTGGACTCAGATTTTATTGGAGGAAAATGCACTAAATCACC

CTGCCAGACTCATTGGTCCAACGTAGTTTGGATGGGTGATGCAGGGATACCAGCCTGTGATTC

CAGCCAAGAGATAAAAGGTCACCTCTTTGTTGATAAAATCTCCAATCGAGTCGTGAAGGCAAC

GAGCTACGGACACCACCCCTGGGGACTGCATCGGGCCTGTATGATTGAATTCTGTGGGGGGCA

GTGGATACGGACAGATCTCGGTGACCTGATATCTGTCGAATACAATTCTGGAGCAGAAATCCT

CTCGTTCCCGAAGTGTGAGGACAAGACGGTGGGGATGA 

図．生成した分子系統樹の例 

遺伝的に異なる 2 つの遺伝子型のウイルスが存在し、それ

ぞれの遺伝子型のウイルスは類似している。HV7601 は U

遺伝子型の参照配列として加えてある。 


